
Geonucleus 1.0 Documentation 

Geological mapping is the most traditional (and the cheapest) way of collecting information from the 

deposits and rocks. The traditional technique of the documentation was refined by generations of 

geologists during the last few centuries. These traditions were implemented into Geonucleus to create a 

tool for precise data recording and visualization, but giving the freedom of pondering the details of the 

observation as well. The Geonucleus creates a well-structured database of the recorded data without the 

necessity of a running database App on the client computer. The observations can be saved in simple 

text format as well, but primarily the xml-based kml (Keyhole Markup Languege) is supported which can 

be loaded into Google Map or Google Earth. This representation is aimed to visualize the observations in 

a well comprehensible form. 

 

This slide from a conference presentation (Albert 2014) sketches up the main structure of Geonucleus. In 

the following text, the details of the different fields are documented. 

https://www.researchgate.net/publication/270566172_Inventorizing_tectonic_elements_in_geological_maps_and_3D_models_-_Problems_Concepts_Solutions


1. The rules for logging information in different fields (categories) 

a) Metadata 
Outcrop ID: the id number or unique name of the observation point. The recommended syntax is the 

following: monogram of the observer and the three-digit serial number of the observation done by the 

concerning person. Do not type other characters (dot, semicolon, comma, etc.) after this code! 

Observers: the full name of the person(s), who took part in the observation. If more than one person is 

involved, the names should be separated by semicolons, but do not type any character at the end. 

Date: the date of the observation (YYYY.MM.DD). After the date - separated with a space - you can type 

the exact time of the observation as well (HH:MM:SS). e.g.: 2012.06.18. 15:09:11 

Latitude: the latitude of the observed site. The geographic coordinate should be given as a decimal 

degree (e.g.: 47.9865), and the datum should be WGS84. This parameter is a default setting in most of 

the commercial GIS programs and GPS instruments. In this textbox the input value must be a number 

between -90 and 90. 

Longitude: the longitude of the observed site. The geographic coordinate should be given as a decimal 

degree (e.g.: 19.9865), and the datum should be WGS84. This parameter is a default setting in most of 

the commercial GIS programs and GPS instruments. In this textbox the input value must be a number 

between -180 and 180. 

Elevation: elevation of the recorded location above sea level (a.s.l.) in meters. In this textbox the input 

value must be a number. 

Importance: the significance of the observed location in a tree-level scale (small – dozens of this type is 

found in the area, medium – it is not rare but for some reason it was unique, high – rare observation was 

made on this site). If the grade is high, written description is recommended in the “Notes” panel (e.g. 

“well developed algal mats”, “cross-stratification is abundant”, or “the most beautiful Oligocene 

outcrop”). 

Type of outcrop: the physical property of the recorded location. Basically three main categories are 

distinguished in natural circumstances: 1) in situ – outcropping rock or undisturbed sediments, 2) in 

debris – physically degraded, but not transported rocks where primary structures are not measurable 

anymore, 3) covered – soil covered sediments, or rock debris, where chemical degradation is also 

significant. The combinations of these basic types are possible. Outcrops due to constructions are usually 

marked as “temporary” ones. 

b) Descriptions 
Location: description of the accessibility to the recorded location, and the physiography of its 

environment. NOT usable characters: <> tab and enter. The extent of the description is not limited. 

Lithological description: detailed description of the observed geological formation from lithological 

aspects. If more than one formation (layer, rock type, stratigraphic category – it depends on the detail of 



mapping) is observed, it is recommended to use geological indices (e.g. in brackets) in the text. It is also 

recommended to use the same indices in the subsequent “Formations” field.  The description of the 

formations should be written according to the grammatical rules of the selected language. NOT usable 

characters: <> tab and enter. The extent of the description is not limited. 

Formations: list of the geological formations observed at the recorded locations. Use descriptive 

indices or abbreviations in the list (e.g.: Ju_sst – upper Jurassic sandstone), and separate the different 

indices with semicolon and space. Put semicolon at the end of the list as well. Check the list in the 

“Stratigraphy” panel, if all the listed formations are present correctly. NOT usable characters: <> \ | / { } ~ 

# tab and enter. The number of the formations is not limited. 

c) Thematic panels 
Stratigraphy: relation of the formations at the recorded location. The sequence of strata can be given 

in two ways: 1) start with the oldest formation and finish the sequence with the youngest one; 2) start 

with the youngest formation and extend the list towards the oldest one. The sequence of formations will 

be encoded in a linear character string which is displayed in the bottommost line. In the first case the 

separator character between the formations is the “\” (backslash), and in the second case the formations 

are separated with “/” (slash) character (e.g.: Ju_sst/Jm_lst or Jm_lst\Ju_sst). To complete this string 

select one of the formations in the list at the left, select one of the remaining formations in the list at the 

middle, select the relation of these two in the dropdown list at the right and press “Submit”. Repeat this 

until all the formations are submitted (submit the last one too). If something goes wrong you can start it 

again by modifying the original “Formations” field. 

In case the contact is a fault, the “|” (vertical bar) character will be displayed. If the formations are 

synchronous the “~” (tilde) character will be used as a separator. If the contact is unknown the “#” (hash) 

is used. If one of the formations is incorporated within another recorded one (e.g. intrusion, intraclast, 

olistolith, etc.), it will be put in “{}“ curly brackets. 

Measurements: measured data of structural and stratigraphic elements in whole degrees of the dip 

direction (azimuth) and the dip angle. Select the type of the measured object in the “Obj. of meas.” 

dropdown list. In the “From formation” list you can select the formation from which the measure was 

taken. Press the “Add” button to add the measurement in the list on the right side of the panel. Selecting 

one of the list elements, an extension of the panel appears where you can add details to the submitted 

data.  The pitch data of slickensides is given as a rotation angle on the measured plane about the normal 

of the plane towards the indicated cardinal direction. Press “Add” to add a pitch data to a selected plane, 

and “OK” if all the details are set. 

Fossils: list of fossils found at the recorded location. Select a fossil name from the “Selectable list” or 

type the name in the “Name of fossil” textbox. Name the fossils on that level of detail which is sure (e.g. 

use “Bivalve shell” instead of “Pecten” if you are not sure about it)! In the “From formation” list select 

the formation from which it was picked out and press “Add”. Selecting one of the list elements from the 

“Fossils:” list on the right side, an extension of the panel appears where you can add details (e.g. size, 

condition, and note) to the submitted data. 



Photos: digital photos or other raster-type data (e.g. scanned drawings) about the recorded location. 

Press the “Add” button to select files from your computer. A file-open dialogue window appears where 

you can select multiply photos to add to the list. After you added the photos, select one of them in the 

list on the right side of the panel; this will be the displayed “profile” photo in the Google Earth pinpoint 

bubble. The photos are shown on the lower left corner of the panel upon selection. In the bottom of the 

panel the full path of the image is displayed. This path will be encoded in the kml-file too, so it is not 

recommended to change the folder structure after adding the photo record to the database, otherwise it 

will point to a false location in the computer. To display the photos in Google Earth bubble low 

resolution images are usually enough, so a small-size (thumbnail) copy of the recorded images are 

created in a subfolder “reduced” in that folder, where the application was started, or the kml database 

was opened from. You can select photos from the internet as well, but a small-scale copy of these photos 

will be created in the “reduced” folder as well. It is also recommended to store all the off-line photos in 

the same folder because a link will point to the folder of the selected “profile” image in the kml, and with 

clicking on it all the photos can be browsed with an image viewer in that folder. Avoid using the “;” 

(semicolon) character in the file- and the path names! 

Samples: List of the samples collected at the recorded location. The purpose of the sampling can be 

selected from the “Collected for” dropdown list. The formation from which the sample was taken should 

be selected from the “From formation” list. Press “Add” to add a sample to the list on the right side of 

the panel. 

Notes: any other information regarding the recorded location (e.g.: theories, alternative formation 

names, opinions of co-observers or experts, explanations, references, etc.). The “Alias (other outcrops 

nearby)” textbox refer to those outcrop ID-s (or identifiable names) which can be found on a source map 

(e.g. documented decades ago by another geologist). NOT usable characters: < > tab and enter. 

______________________ 

2. Handling the documentation 

a) Recording the typed in data 
The “Add/Update” button saves the typed data in the database, but until it is not saved in the file menu 

the database exists only in the memory of the app. If the “Outcrop ID” is not identical to the already 

saved ID-s then pressing the Add/Update button will create a new element in the database. This can be 

checked in the dropdown list next to the “Outcrop ID” textbox. If an ID is already in the database, 

pressing the “Add/Update” button will overwrite the existing record. To avoid the unintended overwrite, 

a confirmation dialogue will appear, which has to be accepted to execute the actual update. The total 

number of recorded points is displayed below the “Add/Update” button. To brows the existing records 

click on the dropdown list next to the “Outcrop ID” textbox and select one of the outcrops. 

If a default field is skipped (textbox is empty or list item is not selected) or incorrect type of data is 

entered, an error message will appear, and the concerning textbox or list is highlighted. Default fields are 

the metadata-type and descriptive ones. 



b) Deleting records from the database 
The typed in data can be erased with pressing the “clear all” submenu in the “Edit” menu. This will not 

modify the database, only the textboxes are emptied. To delete a record from the database, select it 

from the dropdown list next to the “Outcrop ID” textbox, and press the “delete selected” menu item in 

the “Edit” menu. All the points in the database will be deleted by pressing the “delete all” menu item in 

the “Edit” menu. A confirmation is necessary to do this in the pop-up window. 

c) Saving the database 
Pressing the “save kml” menu item in the “File” menu the database is saved in a kml file, which is 

designed to be displayed primarily in Google Earth. This primary file structure however, is not suitable to 

exchange information with other GIS applications. To do this the “export” submenu is recommended. 

Here the most primitive AscII tab format or a simplified kml format is recommended. The latter is perfect 

for example in Global Mapper. Exporting an AscII report file with the “export” menu item, will copy a 

row-by-row inventory of each recorded outcrop from the database. 
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